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Map Properties 
 

We will start by opening ArcMap and then opening the d:\layoutclass\layout8_3.mxd.  
This project has the data already in the Data View that we will be using to make our 
layout. 
 

Go to the File drop-down menu and select Map Properties .  In the 
Map Properties dialog, you can change the name of the map document and add 
metadata type information that would be beneficial to other users. 

 

 
  

 
 
 
 
 
 
 
 



The Data Source Options give you the option of storing path names as full path names 
or relative path names.  This involves hyper-linked information so we do not need to 
worry about it in this class. 
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Data Frame Properties 
 

Right-click on the Layout view (middle of view) or the Data Frame in the Table of 
Contents and choose Properties from the drop-down menu.  The Data Frame 
Properties window will appear; it has eleven tabs.  We will not look at all these tabs, 
only the General tab.   
 
Add/change the name of the data frame and add a description. In the Units box, set the 
Map units to the units of measure used in the projection for the data – in this case, feet.  
Set the Display units to whatever unit of measure you want to use when using the 

measure tool .  (Note:  The Map units must be set to match the unit of the projection of the 
data.  If there is no projected data, then you do not have to set it.) 

 

Reference Scale :  The scale of the data frame used, as the 
reference scale, to which all symbols and text in the data frame will be made relative.  
Setting a reference scale is like "freezing" the symbol and text sizes, used in your data 
frame, so the way they look at the reference scale is maintained at all scales.  Regardless 
of the map scale, text with a reference scale always takes up the same amount of 
geographic space on the map. 
 
In our case, we will set the Reference Scale at 4800.   

 
The Rotation simply spins your view the number of degrees, + or -, you specify.  We 
won’t change the Rotation or the Label Engine. 
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Layout View 
 

The Layout View page is where you prepare maps for production or presentation.  This 
page is where you place map elements such as: titles, legend, scale bar, and north arrow 
(see page 6).   

 
To access the Layout View page, click on the Layout View button at the bottom left of 

the view frame .  This will switch you to a view with the Custer County data frame 
visible on the page.   
 
If you use the Select Elements tool in the Layout View it will only be able to select 
layout graphics and text.  The elements you add to a Layout View are saved in the data 
frame. 
 
You are able to edit your data in the Layout View but this work needs to be done within 
the data frame or you may get some unexpected results.  Editing is accomplished by 

selecting the Editor button  on the Editor toolbar and then choosing Start 
Editing. 
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Toolbars 

 
The Layout View has its own toolbar.  You must be careful to use the correct toolbar.  
You can manipulate both the Data View and Layout View from this page.  The toolbar 
labeled Tools manipulates the Data View and the bar labeled Layout manipulates the 
Layout View. 

 

 
 

Toolbars can contain menus, tools, buttons, combo boxes, or edit boxes.  All toolbars can 
be floating or docked, just like in Word.  A floating toolbar is one that is free floating 
over your view.  The docked toolbar is set into a border of the view on any side.  You can 
even create custom toolbars of elements that are frequently used. 
 
Dock and undock a couple of the toolbars and set things up the way you want. 
 
If you need to add toolbars, go to the Main Menu choose View and then Toolbars.  
Check the toolbars you want to appear on your map, or uncheck the ones you don’t want.   
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Page Setup 

  
We are going to set the map to be tabloid size, 11x17, and landscape.  Go to the File 
menu and choose Page Setup.   
 

 
 
The Page Setup window will appear.   
 

 
 
Uncheck Same as Printer.  If you are going to share this map document with someone 
that does not have access to the same printers as you, then you need to uncheck Same as 
Printer.  Same as Printer ties your page setup to the specific printer parameters.   
 
Change both the Standard Page Sizes and Printer Page Size to Tabloid (11x17) and the 
Page Orientation to Landscape.  Leave the box checked for Scale map elements 
proportionally to changes in page size. 
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Tool Options  

 
Go to the Tools menu and pick Options at the bottom of the drop down menu.  The 
window below will appear. We will look at four tabs: Layout View, TOC, Raster, and 
Data View. 
 
Click on the Layout View tab.  
Here we have several options that 
will assist with activating helpful 
tools in our view, for creating a 
map.  We want to show the 
Scrollbars, Guides, Rulers, and 
Snap to Guides.  Set the Snap 
Tolerance: according to the size of 
your map, the larger the map 
generally the larger the snap 
tolerance.  If you set your Snap 
Tolerance to high, on a small map 
with lots of elements, you may 
have objects move that you don’t 
want to move.  Setting your Snap 
Tolerance to small, on really large 
maps, makes it a tedious task to get 
the object to snap to the guide.  If 
you check more than one item in 
the Snap elements to box, the 
order from top to bottom, will be 
the priority order to which 
elements in the map will be 
snapped.  If desired, highlight the 
object you want to move and use 
the arrows to the right to change the order.   
 
Next, click the TOC tab.  We are going to add the selection tab to the Table of Contents 
so we can easily specify the layer we want as the selectable layer.  Check the box next to 
Selection in the TOC tab options box.   
 
Click the Data View tab.  We can change the Scrollbars, and how the view resizes when 
changed.  If it isn’t picked already, choose the radio button  for Redraw the Display. 
 
Click the Raster tab.  This is just to show you what is here.  If you work with Raster data 
you will want to remember this page.  It is here where you can select what kind of images 
you want ArcMap to recognize, set when to have pyramids built (allows quicker display 
of large maps), and change color scheme for the images.  
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Components of a Map Layout   
 

Title       Descriptive text (optional) 
Map (View)      Inset maps (optional) 
Legend      Neatlines (optional) 
Scale bar 
North arrow 
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Setting Guides 

  
In the tool option section above we activated Snap to Guide.  Guides are useful to 
manage the elements on your map so they are arranged perfectly.  We will use the guides 
to set the view frame, but not the other elements of the map; we will use the alignment 
tools for those.  Map elements only snap to the guides at their edges.   

 
We want to arrange the Layout View to be 5 inches from the left, and ½ inch from the 
edges.  We also want a neatline around all the elements to be a ½ inch for all edges. 
 
To add a guide, simply click on the ruler where you want the guide to be 
set.  Now add guides at the measurements mentioned above.  If you set a 
guide in the wrong spot, you can left-click and hold on the guide arrow, 
then slide it up and down the ruler to where you want it.  To manage guides, right-click 
on the guide arrow.  In this window, you can remove a guide, hide 
the ruler, or choose options, and this will go to the window for 
tools options where we chose Snap to Guide (page 7).  As you can 
see in this dialog window, another way to set a guide is by right-
clicking on the ruler and choose Set Guide. 
 
Now we will set the View Frame to fit these guides.  Click once 
within the Layout View to activate the handles.  It does not matter 
which handles you use, move your cursor over the handle so it changes to directional 
arrows.   
 
 
Click and hold the handle then slid the edge to the appropriate guide.   
 
You will see it snap to the guide.  Adjust each side of the view and the neatline, to the 
guides.  
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Style Palette 

 
There are an enormous number of styles available in ArcMap.  
The styles are broken into industry-specific groups to assist 
you when looking for specific symbols or elements to add to 
your map.  By default, when you save a symbol, a personal 
style sheet is created on your c:drive.  You can also create 
styles and place them on your network for others to use.    
 
ESRI symbols are common ones, and the use of widely 
recognized symbols helps you to communicate with the map 
users.  So, when possible, avoid creating your own unique 
symbols and elements when an easily recognized one already 
exists.  Styles help you maintain standards for symbols, colors, 
patterns, and methods between your maps, which can help 
create a professional appearance to the maps sent to your 
customers.   

 
The ESRI Styles and your c:drive style are displayed by 
default.  We can change this to display only your c:drive style 
and the custom style one we create.   
 
First, let us explore what the default shows.   
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Click once on the symbol for the custca04 layer and the Symbol Selector window will 
appear.  If you scroll down, you notice that the ESRI default has a large list. We do not 
want to search through all these symbols every time we want to modify a symbol or 
element, so we will deselect the ESRI style. 

 

 
 

If we do not want a Style referenced, go to the Tools menu , then Styles, then 
choose Style Reference, as shown below. 
 
   
 
 
The Style References window will appear.  
This is where you can set the default Styles 
that would appear on your Symbol Selector 
window.  In this example, both ESRI and 
gisuser are checked.  These are now 
referenced and their symbols and elements 
are available throughout ArcMap.  Notice 
that gisuser is grayed out.  It cannot be 
unchecked; this is the default style created 
on the c:drive.  Uncheck the ESRI style.  
This will only be maintained for this .mxd.  
It will change back to the ESRI default when a new document is created.  Return to the 
Symbol Selector window.  What has changed? 
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Create Custom Style 

 
Creating a style for your office is an important step in maintaining continuity, or 
standards, for the maps produced.  We will create a custom style and then go over a 
couple ways to add new elements.   

    
 To create the style, go to Tools, then Styles, then Style Manager. 
 

 
 

The Style Manager window will appear.  In the left column, (Table of Contents) you 
should only find the two default styles; ESRI and the c:drive.   

 
In the upper right corner of the Style Manager window, click the 
Styles button.  The menu of all the Styles will appear.  At the bottom 
of the list you will find two selections: Add and Create New.   
 
Select Create New… and a Save As window will appear.  In this window, at the top, 
select where you want your new Style to be saved.  Place it in the Layoutclass folder (on 
the network at your office) and enter in a name.  Notice that your file will be saved with 
the extension .style.    
 
Now click on the Save button. 
 
Notice in the Style Manager window your Style appears in the catalog tree.  At this 
point, the new Style is empty.  Click on the plus sign , next to your folder, and 
expand the new Style.  All the variety of symbols and elements are broken out into 
folders.  If you create a line style, you will want to have it reside in the Line Symbols 
folder.   
 
At this point, expand the ESRI style and look through the folders to see what type of 
items belong in each folder. 
 
Within the custom style folder, the symbol folders are white; this means they are empty.  
They will turn yellow, once you have added items to them. 
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Adding Elements to a Style 

 
Add items to the folder by opening the symbol folder you want to add an element to, then 
right-click in the right window of the Style Manager window, and choose New.   

 
Double-click on the line Symbol folder.  Move to the empty window on the right side, 
right-click, and a dialog opens with New as the only active item.  Move your cursor over 
New, and Line Symbol will appear. Click on 
Line Symbol.   

 
The Symbols Property Editor window will appear.  We will create the symbol you need 
using the tools available.  There are a plethora of choices to modify the symbols you want 
to create.   
 
Using the tools available, create a dashed line with large spaces between the dashes. 
 
A second method, of adding items to your symbol folders, is to simply copy and paste 
them from existing folders.  Open the ESRI Style and open the Fill Symbol folder.  In 
the list that appears, right-click on Hollow and choose, copy.  Return to your Custom 
Style and open the Fill folder.  Right-click and choose paste in the empty window.  This 
is how we will populate the Custom Style you have created. 
 
Return to your Data View.  We are going to change all the symbols for our layers.  Click 
once on the symbol for the custca04 layer.  The Symbol 
Selector window will appear.  We want the symbol for this 
layer to be a 0.5red outline with no fill.  Using the tools on 
the right, create this symbol.  The Preview pane, at the top, 
right will reflect your changes.   
 
Click the Save… button at the bottom.  The Save Symbol 
window, seen below, will appear.  Enter a name for the 
Symbol you created and enter a Category.  The Category is 
another tool to further organize your symbols within the 
Symbol folder.   
 
Click OK, in the Save window, then click, OK in the 
Symbol Selector window. 
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The Save…button saves your symbol to your c:drive default Style.  Once you have 
changed, and saved, all the symbols of the layers in the data frame, return to the Style 
Manager and copy/paste or cut/paste the new symbols to the Custom Style. 
 
(Shortcut keys…ctrl+a, ctrl+c, ctrl+x, ctrl+v …etc.)  
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Insert Map Elements 

  
 All the elements listed below can be accessed from the Insert menu. 

 
A) Title 
 

By inserting the Title through the Insert menu , the title of the project (.mxd) 
will be inserted as the title.  You can adjust the font of the text, after you insert the 
title, using the Draw toolbar buttons.  One advantage, is that the title is centered on 
your map. 
 
There are a couple of other issues with using this method for your title.  The size of 
the title is a default relative to the reference scale we set on page 4.  It usually is not 
what is needed for the map.  An additional issue, the .mxd name, is rarely named an 
appropriate title for the map.  File names should still be limited to 8 characters, and 
cannot have spaces between words, as many map titles do.   
 

B) Text 
 
A good alternative for the title, and to enter all other text, is to use the Insert Text 

selection , or the New Text tool .  The primary difference is the text 
using the Insert menu will automatically be placed in the center of the map.  When 
using the New Text tool, you can place the text wherever you want to.   
 
If you know the font you want to use, set those values on the Draw toolbar before 
choosing either tool.   
 

 
 

Set the font to be Arial, 48, and choose your own color.  Pick the New Text tool and 
move your cursor to the approximate area you want your title.  Click the page once.  
A dialog box will open, and then enter in a title of your choice. 
 
If you have a disclaimer saved as a word document, you can open the word document 
and copy/paste the wording into the text dialog box instead of typing in the 
information.  The font selected in the Draw toolbar will overwrite the word document 
font, so make sure you change it from the title font you choose. 
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C) North Arrow 
 
The most difficult task when adding a North Arrow is determining which one you 
want to use!  The ESRI Style alone has over 100 different North Arrows.  Go to the 
Insert menu, pick the North Arrow, and click on the map.  The Symbol Selector 
will appear, then start your search for your favorite arrow. 
 
Since we do not want to search through these again, we will save your selected arrow 
symbol to your Custom Style, as we did before with the Fill symbol on page 11.  
You can also save your title text, and disclaimer text, to your Custom Style.   
 

D) Scale bar 
 

The Scale Bar can be frustrating if you insert it before you set the view image at the 
scale to be used.  So, first, check your scale on the Standard toolbar to ensure it is set 
at 15000.   
 
When you choose the Scale Bar, from the Insert menu, the Scale Bar Selector 
window appears.  Choose the type of Scale Bar you want to use, by clicking on it 
once.  You will see your selection appear in the Preview frame.   
 
Next, click the Properties button.  The Scale Bar properties window will appear.  
We will change numerous items in this window.  But first, take some time to explore 
what happens to your Scale Bar when you enter different values. 
 
The values we want to enter are:  
 
a) Number of divisions:  “3”  
 
b) Number of subdivisions: “1”  
 
c) Check the box for “Show one division 

before   zero”  
 
d) When resizing…choose “Adjust width” 
 
e) Division Units: “Feet” 
 
f) Label Position: “after labels” 
 
g) Label: “Feet” 
 
 
You can access the window, to make changes to the font of the label text, by clicking 
the Symbol… button. 
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Under the Numbers and Marks tab, once again explore the effects of each change.  
We won’t set anything specific in this area, but make the changes you want for your 
Scale Bar. 
 
The Format tab is where you will change the format of the text on your Scale Bar, 
and the colors of your Scale Bar.  Again, we will not specify changes, but explore the 
effects of the changes made with these tools and make your own changes. 
 

E) Scale Text 
 
Scale Text indicates the scale of the map and features on the map.  Scale Text tells a 
map-reader how many ground units are represented by a map unit; for example, "one 
centimeter equals 100,000 meters."  One drawback of Scale Text is, that if a printed 
copy of the map is duplicated at another scale (i.e., enlarged or reduced), the scale 
text will be in error.  Scale bars do not suffer this limitation. Many maps have both 
Scale Text and a Scale Bar to indicate the map scale. 
 
Insert Scale Text on your own. 

 
F) Picture 
 

Images can improve the esthetics of the map, but be careful so they do not draw 
attention away from the focus of the map.  We will insert the State Tax Commission 
logo.  As we have done before, use the Insert menu for this object.  The first window 
that opens prompts you to select your image.  Navigate to d:/LayoutClass/, select 
ISTClogo.tiff, and then click Open.  The image will be inserted in the center of the 
view, and probably very large.   
 
We will change the size using the properties, instead of 
grabbing the handles and shrinking them that way.   
 
Right-click on the image.  At this point, you have several 
options concerning the orientation and alignment of the 
image file.  But we want to resize it, so choose Properties.  
Click on the Size and Position 
tab.   
 
We want to check the 
Preserve Aspect Ratio button 
and then type in 1.75 in the 
Width box.  Because we chose 
the Preserve Aspect Ratio, 
the Height will automatically 
adjust to maintain the images 
existing height/width ratio.     
 



 19

G) Inset Map 
 
The inset map is a Custer County reference map.  We are 
going to add this data by creating another data frame.  Pick 
Data Frame from the Insert menu options.  A blank data 
frame will be inserted in the middle of the map. 
 
Make sure the new Empty Data Frame is active in the Table of Contents, as we 

want to add data to it.  Click on the Add Data button , or right-click on the 
Empty Data Frame and choose Add Data.  Then navigate to the Layout folder and 
pick the Custer County shape file.  Open the shape file.   
 
An image of Custer County will appear on the map.  Move the Inset Data Frame 
over to the left side of the map with the other elements we have added.   
 
Now go to the Table of Contents and change the Fill pattern of the county symbol to 
be hollow with a black outline.  After you change the fill pattern, save it to your 
Custom Style, you remember how by now.   
 
Area of Interest:  Now we need to add an Area of Interest rectangle to the inset 
map.  It does not matter where you add it.  Go to the New Rectangle tool on your 
Draw toolbar.  Click the tool and draw a box over the county map of the 
Inset map.  The box you create, by default, will be a solid rectangle; change 
it to a hollow fill pattern with a .5 red outline, then save this to your 
Custom Style. 
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H) Legend 
 

As with the other items, we are able to manipulate the legend quite a bit.  When you 
insert the Legend, you are prompted with a Legend Wizard.  If only the Custer 
County layer is showing in this first window, the wrong data frame is active.  If this 
happened, close the Legend Wizard, go to the City of Stanley data frame, right-click, 
and choose Activate, or double-click on the Main View Frame to activate it.   
 
Re-insert the Legend on the map.  You should see all the layers in the main data 
frame. 
 
Here, we can choose which layers we actually want to show in the Legend.  We will 
leave all the layers selected.  Move a couple layers back and forth, move all layers at 
once, and rearrange the order of the layers, to familiarize yourself with how these 
operations work. 
 

 
 
Once you have arranged the layers in the order you want them to appear in the 

Legend, click the Preview button .  The Legend will appear on the map.  
If everything appears to be ok, then click the Preview button again so the Next button 
reappears in the bottom right corner. 
 
Click Next.   
 
The next window will be used to edit the legend title.  In this window, change the 
Font to “16” and “bold”, then change the “Justification” to “center”.  You can look 
at the Preview again. 
 
Click Next. 
 
In this window, change the Border to a “Double line”, the Background to “Grey 
10%”, the Drop Shadow to “black”, the Gap to “20”, and the Rounding to “15%.”  
Click on the Preview button and view the changes.  Re-click the Preview button to 
turn it off and then make any changes you would like in this window. 
 
Click Next. 
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This window is to change the symbol appearance.  You can change symbols 
individually.  For example, change the streams layer to the “Flowing water” 
symbol.  Remember to keep the symbols similar in width to maintain a uniform 
appearance in your Legend.   
 
Change the other symbols. 
 
Click Next. 
 
This is the last window.  In this window, we manage the spacing between each item 
in the Legend.  Make changes to the spacing and preview your changes.  The default 
is 10.89 for the legend title, and 6.79 for the rest of the items.  Change a few of these 
to see how the Legend changes. 
 
Click Finish. 
 
The Legend you have created will not be located where you want it on the map; 
move it to the left column with the rest of elements.  Either drag it with your mouse 
pointer, or use your arrow keys. 
 

I) Table or Objects 
 

There is not an Insert table selection in the Insert drop down menu.  Tables are 

found under the Insert Object selection .  There are about twenty 
different object types that can be placed on your map; documents to .wav files 
(sound) to Power Point presentations.  We are going to insert a Word table, the List 
of Changes.  The document will be dynamic, so you could make changes to it as the 
information in the table changes. 
 
In this first pop-up window, we can choose Create New object or Create from File.  
If you choose Create New, a new blank or empty object will be inserted.  If you 
choose Create from File, you can insert any current object.   
 
Choose the radio button for Create from File. 
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The Object Type: will change to a Browse menu.  Navigate to the LayoutClass 
folder and open TCA.doc.  
 

 
 
There are two other options on this window.  You can check the box for Link 

 to create a dynamic link to the inserted object.  When you do, the changes 
can be made to the original document and they will change in the file in the map 
document.  Also, if you double-click the file on the map and make changes, these 
changes will appear in the original file.  If left unchecked, changes to either will not 
be reflected in the other.   
 
The second option is Display As Icon.  When this box is checked, 
the object content will not be displayed on the map, but the Icon 
you choose will be.  If you share these maps digitally, the user 
would only have to double-click the Icon to see the contents.  This 
may be useful if the information you want linked is too large to be 
displayed esthetically on the map.   
 
Click OK. 
 
The object is inserted at the center of the view, move it to the left with the other 
elements.  Place the table at the bottom of your elements, on the left. 
 
The table that is inserted is too large.  Usually, we can right-click on the element and 
get a properties window to make changes like size, but not with inserting an object.  
The size change needs be done by left clicking, holding a handle, and shrinking the 
object. 
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Aligning and Grouping Elements 

 
A) Grouping  
 

If we align the elements now, the Area of Interest box will no 
longer be in the location we need it to be.  To avoid having to 
deal with these two related graphics, we can group them.  
Grouping makes multiple elements act like one element.  
Select the elements you want to group together, then right-
click and pick Group.   

 
B) Alignment 

 
The elements arranged on the left side of the map are not 
aligned.  These elements can easily be aligned and distributed 
(spacing) by using the proper tools.  First, we need to solve the 
problem of the elements being centered between the view, and the neatline on the left.   
 
We need to create a New Rectangle.  Draw the rectangle 
around the elements on the left side of the map.  After it is 
drawn, snap each side to the nearest guide.  Now we have a 
map element we can use to center the other elements. 
 
(Note:  Objects, such as the table we inserted, cannot be aligned 
or distributed with the other elements.) 
 
Using the Select Elements tool, draw a selection box around 
all the elements on the left side of the map, including the 
new rectangle we just drew.  All the elements should be 
selected.  You can tell when an element is selected because 
the adjustment handles appear around the element.   
 
Hold down your shift key and click on the table.  This 
should deselect the table/object that cannot be aligned. 
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We can access the alignment options by either right clicking on a selected element, or 
by going to the Drawing button on the Draw toolbar 
and choosing Align.  We have the option to align 
right, left, top, bottom, or center.   
 
Make sure the handles for the neatline box are blue 
and the rest are green.  The blue handles indicate 
which of the graphics is the dominant graphic.  The 
dominant graphic will be the one used as the guide 
for moving all the other graphics. 
 
Choose to Align “center.” 
 
Now all the elements will be centered within the 
neatline we created on the left side.  Next, we will 
distribute the items evenly, vertically.  We are going 
to set two more guides to help with this.  As we did 
before, set two guides on the vertical ruler at one inch from the top and bottom 
edge of the map.  These should be at the 1 and 10 inch marks.   
 
Nudge; do not drag the top and bottom elements toward these guides until they snap 
to the guides.  If you try to drag the graphics with your mouse into place, you could 
move it out of center alignment.  Click the top graphic so it is selected.  Using your 
arrow keys, move it up until it snaps to the new guide.  Repeat this for the bottom 
item; moving it down to the new guide.   
 
Using the Select Elements tool, select all the items on the left except the table 
(object).  Right-click on a selected graphic; choose Distribute and then Distribute 
vertically.  This will space the elements evenly. 
 
We have many options in the Alignment and Distribute menus.  Experiment with 
these options and see what each does to the elements you select. 
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Labeling 

 
We want to show the tax code area numbers so we can tell which tax code area any 
particular parcel lies within.  
 
Go to the custca04 layer, right-click, and choose Label Features from the menu.  By 
default, ArcMap chooses an item from the Attribute field.  Why any particular item is 
chosen over another for the default, is one of the great mysteries of the ESRI software.  
The current label is not the information we are looking for.   
 
First, we need to determine the correct item name.  Open the Layers Attribute table by 
right-clicking the layer and selecting Open Attribute Table.  Scroll to the right.  We see 
that TCANUM is the item name we need to use. 
 

 Close the Attribute table. 
 

Right-click the custca04 layer and choose Properties.  The Layer Properties window 
will appear.  Choose the Labels tab.  We will change several items in this window.   
 
The check box for Label Features in this layer should be checked already.   
 
For the Method, we will choose Label all the features the same way.  If you choose 
Define classes of features and label each class differently, the SQL Query button would 
appear and you would compile code to create classes.  
 
The Label Field, in the Text String box, is where you choose the item or field from the 
Attribute table to label the map.   
 
Choose TCANUM.   

  
In the Text Symbol box, click on the Symbol button.  Change the font to a size and color 
of your choice. 
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The Label Placement Options provides controls for your labels.  The first option is how 
to place labels.  As an example, a highway usually has many segments that are labeled 
but you do not need twelve labels placed on one 
feature in the map.  In this case, you would choose 
Remove duplicate labels.  If you need each feature 
to have a label because they are all uniquely 
identified, then you would choose Place one label 
per feature part.  Also, for Place one label per 
feature, duplicate labels will not be removed.  For multi-part polygons with the same 
label, and you want all the polygons to have labels, choose the bottom radio button.  
Choose Remove duplicate labels. 
 

The Scale Range button  will allow you to set a scale at which labels will 
show or not show.  If your map has many small polygons for a feature, and having the 
labels for those show on the map makes the map unreadable, than set a scale range for 
those labels.  (Note: These labels will not appear on a printed map) 

 

The Label Styles button  will bring up the styles with standard labels for 
you to choose from. 

 
Look at the Label Properties for the Streets layer.  There are a few more options for 
labeling line features. 
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Annotation 

  
Annotation is used when you have text you want to store to a specific position on your 
map.  We can leave the text as a label, but you cannot manipulate the individual labels, 
which you can do with an Annotation label.  You make changes to individual 
Annotation labels in the Data View.  Label locations are manipulated and controlled by 
a set of placement rules, some of which we looked at on pages 25-26.  We can 
manipulate the appearance of individual Annotation text. 
 
The window below the 10N13E_parcels layer should be checked by default.  Also, the 
default for storage options should be In the map. 

 
The layers we are using include the whole county, but we are really only interested in 
labels in four sections.  To avoid creating large annotation data sets, we can limit the area 
that is labeled. 
 
In the Create Annotation for: box, choose Features displayed in the current extent.   
 
Leave the boxes checked for Generate overlapping labels for all layers and Display 
overlapping labels in the overflow window. 
 
Click OK. 
 

 



The annotation text Overflow window will appear.  This is a list of all the labels that overlapped 
another label. Currently these labels do not appear on the map.  By right clicking on one of the 
labels in the window, we get our options for manipulating these labels.   
 

 
 
Pan To Feature or Zoom To Feature do move the Data View data.  As a result, you will have 
to re-center the view if you use these functions.  Use the options in the window to see how they 
work with the labels. 
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Transparency 

 
When overlaying two polygon layers that have solid fill symbology, the Effects toolbar 
allows you to make one “see through”.  This is especially useful when working with 
raster data.   
 

 
 

For the Layer, choose the City Layer.  Click the Adjust Transparency button  and 
the Transparency sliding scale will appear.  Move the Transparency 
to about 70%.  You will see that we can still distinguish the city layer, 
but now we can see the parcel lines under the city. 
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Joining Tables 

 
The typical reason for joining, an external table to a layers attribute table, is to extend the 
information available about the geographic features of your map.  For example, linking 
CAMA data to parcel data allows you to use the CAMA data with a counties parcel layer.   
Joins are based on the common values of a field found in both tables.  The field names do 
not have to match.  With the parcel data and CAMA data there is a many-to-one 
relationship.  In other words, there are numerous polygons with the same unique parcel 
number in the attribute table, but the CAMA table has that value once in the field we are 
linking it to (“many-to-one” relationship).  You will use join for “one-to-one” and 
“many-to-one” relationships.  Use relate for “one-to-many” and “many-to-many 
relationships.” 

 
Right-click on the layer you wish to perform a 
join and choose Joins and Relates. 

 
Choose Join. 

 
The Join Data window will appear.  The top 
drop down window gives the choice of 
“joining to a table” or “doing a spatial 
location join.”  Choose Join attributes from 
a table.  

 
1. Choose the item/field of the layer you 

wish to use for your join. 
2. Click the Browse button, navigate to the 

Layout8_3 class folder, and choose 
CAMA.dbf. 

3. Choose the ParcelId field from the 
CAMA data.  It does not have to have the 
same field name. 

 
Click the Advanced button.  If our target table was a really large table, or we just don’t 
want to display non-related fields, then choose Keep only matching records. 

 
The joined records will be appended to the attribute table. 

 

 
 

If you want to read more about joining data, then click on the About joining data 
button. 
 



Section 18: 

 

Scale for Plat Maps 
 

By Idaho code, plat maps should be 30 x 36 (this is going to change) with a View Frame 
being 30 inches in width and height.  At this page size, we can set some values in ArcGIS 
to help us manage maps.  Note that the scale will change if you change the page size.  We 
will compare the map, we created above, to these changes. 

 
Open a New empty ArcMap project and from the Jerome folder in the LayoutClass 
folder, bring in the file county.shp.   

 
Go to Page Setup and change the page size to 30 x 30.   

 
We want to have a layout with four sections in our view.  If we want 1-inch to equal 400 
feet, we will set our scale at 1:4800.  If we zoom in to one section, then set the scale at 
1:1200 and the measure will be 1 inch equals 100 feet. 

 
(Reminder: A scale of 1:4800 means 1 inch on the map equals 4800 inches on the ground) 
 

Make these changes to your map. 
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Setting Extent 

 
Extent: Setting the Extent is helpful when you do not want anything to change regarding 
the amount of data in your view.  For example, the data we used for the Custer County 
map included the entire county.  We could have set the Extent to only include the area 
we were interested in, and only that area would have been drawn.  If you avoid drawing 
on large data sets, it will save you time. 
 
With the Jerome data, we will set the Extent for four sections so we do not draw on the 
data set for the entire county. 
 
First, go to the Layout View and move your cursor over the window.  You will notice 
numbers changing in the bottom left of the window.  The far left numbers are the page 
measurement numbers, and the others are the X Y location numbers.  
  

 
 

Record the numbers when you move your cursor to the left, right, top, and bottom of the 
view to include what you want your view to contain.  The first number will be used for 
the east and west values and the second number for the north and south values.  You 
should have four unique numbers recorded.   
 



 31

Go to the Data Frame, right-click, 
and choose Properties.  In the Data 
Frame Properties window, choose 
the Data Frame tab.   
 
Choose the Fixed Extent radio 
button.  The grayed-out values 
below will become active.   
 
Enter in the values you recorded, 
and click OK. 
 
 
 
 
 
 
 
 
 
 
 
Return to the view window and try to pan the view as before.  The Pan and 
Zoom tools, on the Tools toolbar, are grayed-out.  The view is fixed.  If you 
change the size of the page, the view will increase but will still only include the 
data you want viewed.   
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Glossary (Copied from ESRI) 
 
Active data frame - The data frame in the view that is currently being worked on.  For example, 
the data frame to which layers are being added. The Active data frame is shown in bold text in 
the ArcMap table of contents.  
 
Attribute -  A piece of information describing a map feature. The attributes of a census tract, 

for example, might include its area, population, and average per capita income.  
Or 

A characteristic of a geographic feature described by numbers, characters, images, 
and CAD drawings, typically stored in tabular format and linked to the feature by 
a user-assigned identifier.  For example, the attributes of a well might include 
depth and gallons per minute.  

Or  
A column in a table.  
 

Extent - The coordinate pairs defining the minimum bounding rectangle (xmin, ymin and xmax, 
ymax) of a data source. All coordinates for the data source fall within this boundary.  
 
Item -   A column of information in an INFO table 

Or 
An element in the Catalog tree in ArcCatalog. The Catalog tree can contain both 
geographic data sources and nongeographic elements such as folders, folder 
connections, and file types. 
 

Join - The process of attaching tabular data to geographic features. Attributes in an attribute 
table are appended to the features in a spatial data table using an attribute or item common to 
both tables. 
 
Layout - The design or arrangement of elements—such as geographic data, North arrows, 
legends, and scale bars—on a digital map display or printed map.  
 
Layout view - The view for laying out your map in ArcMap and ArcReader. Layout view shows 
the virtual page upon which you place and arrange geographic data and map elements—such as 
titles, legends, and scale bars—for printing.  
 
Scale - The relationship between the dimensions of features on a map and the geographic objects 
they represent on the earth, commonly expressed as a fraction or a ratio. A map scale of 
1/100,000 or 1:100,000 means that one unit of measure on the map equals 100,000 of the same 
unit on the earth.  
 
Scale bar - A map element that shows the map scale graphically.  
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Table of contents - In ArcMap, the table of contents lists all the data frames and layers on the 
map and shows what features the symbols in each layer represent. ArcScene also has a table of 
contents.  
 
Toolbar - A set of commands that let you carry out related tasks. The Main Menu toolbar has a 
set of menu commands; other toolbars typically have a set of buttons. Toolbars can float on the 
desktop in their own window, or you can dock them at the top, bottom, or sides of the main 
window.  
 
Views - Different ways to see the contents of the selected item in the Catalog tree in ArcCatalog.  
 
 

 


